**Blackboard Web Community Manager Training**

The Blackboard Web Community Manager is a remotely-hosted content management system that allows online editing from any location. You can access this from any computer with Internet access and edit any section or pages you have been granted rights to.

*Underlined items are links to other guides.*

*Ver. Changes listed on last page.*

## Terminology and Website Structure

<table>
<thead>
<tr>
<th><strong>Site</strong></th>
<th>The Waco ISD website is the site</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Subsite</strong></td>
<td>All campus are sub sites of the district site.</td>
</tr>
<tr>
<td><strong>Channels</strong></td>
<td>The main navigation categories (main menu) of any site are known as channels.</td>
</tr>
<tr>
<td></td>
<td>- A channel is like a Drawer in a file cabinet containing similar information.</td>
</tr>
<tr>
<td></td>
<td>- Channels are visible on every page of your site.</td>
</tr>
<tr>
<td></td>
<td>- They provide visitors to your website with consistent navigation throughout the site.</td>
</tr>
<tr>
<td><strong>Sections</strong></td>
<td>Within each channel there are sections. Sections are containers used to group together one or more pages. Each new section added to a channel will automatically show up in the channel drop-down. (A section can be hidden from navigation if desired).</td>
</tr>
<tr>
<td><strong>Section Editor</strong></td>
<td>A Section Editor has editing privileges for a section, which includes the ability to add, edit, and delete pages in his or her section. Section Editors can control what content can be viewed by individual users or groups of users through the management of Viewing Rights.</td>
</tr>
<tr>
<td><strong>Pages</strong></td>
<td>A section consist of one or more pages. This is the way content is displayed to the end user.</td>
</tr>
</tbody>
</table>
| **Apps within page** | Apps are the content building blocks of pages. You can have one or more apps on a page. Each app offers different functionality. Apps help you keep your pages interesting and organized.  
- Use a single app to display a single type of information such as a list of links (Link Library App) or a calendar (Calendar App) on a page.  
- Use multiple apps when you want to organize different types of information on a single page.  
- You can share apps with individual users or groups of users. They can add them to their pages, but they cannot edit or permanently delete them. Sharing apps is particularly helpful if you want the same information posted in multiple places on your website, but you only want to edit it once. |
| **Workspace** | Workspace is the area in Site Manager where you complete your Editor tasks. |
Signing In

To sign into the website, go to any the Waco ISD site or any sub-site. On the right you will see the User Options button. Here you will find the Sing In option.

Once logged in, registered users gain access to blocked pages and editors gain access to Site Manager. Site manager is the tool used to manage content on the website.

Site Workspace Overview

Site workspace is the area where you can edit your site’s Homepage and the main calendar for the web site.

Here you see a list of your Channels and the number of sections within the channel. You can click on the section bubble to navigate to that section. The Channels Tab, where you can add channels to your site and find advanced channel configuration, is also available here.

Set editing and viewing rights on the Directors and Viewers tab. Common tools area houses the Files and Folders, Forms and Surveys, Friendly Web Address Mapping, Minibase and Photo Gallery (links to common tools descriptions provided below).

Adding a Channel

Before channels can be added to the channel bar they must exist in the Channel Library, which is managed by site administrators. The Channel Library is a master list of available channel names. Using the Channel Library ensures consistency across all sites.

1. In Site Manager, find the site or subsite you want to add new channels to.
2. Select Channels tab.
3. Select Assign Channel.
4. Select a channel from the Channel Name menu.
5. Optionally, provide contact information. *Users see this information in general messages from the channel.
6. Optionally, type a Calendar Notification Email address. *Notifications are sent to this address when other calendars submit requests to push events to this calendar.
7. Select Save.
Channel workspace Overview

Each Channel typically contains one or more sections. Sections are created by site directors, subsite directors, or channel directors.

The channel workspace is where you can add sections to your channels. In this area you can also sort your active sections by clicking the Sort button.

Adding a Section

1. From Site Manager, find the channel you want to add a section to.
2. Select New Section.
3. Type a Section Name.
4. Type a Menu Name. The menu name appears in the navigation on the end-user website.
5. Select a Section Configuration from the menu. Choose Blank if you want a blank section.
6. Optionally, add contact information.
7. Select Save.

Section Workspace Overview

Section Workspace is the area where you create, organize and edit pages. Once logged into the website you can access this Workspace by going to Site Manager under User Options. You will only see the section workspace you have access to.

Summary Tab - where you will manage your current pages and create new pages. The Summary tab is made up of four different elements Current Pages, Common Tools, Pending Comments and Total Visits.

New Page – takes you through creating a new page.
Organize Page – allows you to organize pages manually or alphabetical order.
Recycle bin – stores deleted pages until you permanently delete them, allowing you to restore them.
Status button – set the page as active or inactive.

Other Section Workspace Tabs
Tools Tab - Manage your section tools and apps, like your Files and Folders, Minibase, App Manager and Photo Gallery
Editors & Viewers Tab - Give others the right to edit and limit viewing rights to your section.
Statistics Tab - where you can view your section statistics. Includes Total Visits & Total Page Views.
How do I Tab - where you go for help and additional resources. You will find guides, helpful links, Videos, and additional resources.
Page Overview

Section Editors can add pages to sections. A page is the way information is displayed to the end user. A page appears can be changed by changing the Page Layout. There are default page layouts available for you to use or you can choose a blank page.

Core Component of a Page

1. Page Layout – The way in which columns are arranged on a page.
2. Columns – Separates apps in a page. You can place one or more apps per column.
3. Apps – These are the content building blocks of a page. You can add multiple apps per page or per column. Apps can be shared with other sub-sites within your site.

Creating a New Page

1. Access the section where you want to create the new page.
2. Select New Page
3. Add a Page Name
4. Select Page type (description is provided below page type title)
5. Save & Continue

*New pages are Active by default. If you would like to work on a page before the public is able to see it set the status to Inactive.

Editing a Page

When you are logged in, an Edit Page button is displayed on the right of any page you have been granted editing rights to. When the button is clicked it will open the page editor.

Here you can edit the content of the webpage you were looking at by clicking the Edit (green pencil) icon. Or you can add apps to the page to display different content.
Adding Apps to Page

Apps are the content building blocks of pages. Adding an app to a page is as simple as locating the app, clicking and dragging it to the desired column. Keep in mind that the page layout can be changed on the Layout tab, adding columns and rows to the page. *See pg. 5, Core Components of a Page.

Apps Overview

As stated before, apps are the content building blocks of pages. Each app is designed to display in a way that is consistent with the type of content contained within the app. Choosing the right app or combination of apps and the right page layouts helps you provide your visitors with adaptive content that automatically responds to the type of device accessing the information and keeps your pages fresh and engaging. You can add multiple apps to a page and columns. Or you can choose to only have one.

Common Apps

<table>
<thead>
<tr>
<th>About Teacher (Teacher)</th>
<th>Content</th>
<th>Image</th>
</tr>
</thead>
<tbody>
<tr>
<td>Announcements</td>
<td>Document Viewer</td>
<td>Links</td>
</tr>
<tr>
<td>Article Library (Articles)</td>
<td>File Library (Files)</td>
<td>Multimedia Gallery</td>
</tr>
<tr>
<td>Calendar</td>
<td>Article Library (Articles)</td>
<td>App Showroom (Full List)</td>
</tr>
</tbody>
</table>
Home Page Apps

Campus homepage will usually contain a Multimedia Gallery and a News From Around The District app. The Multimedia Gallery can be edited by your site editor, but the News From Around The District (Headlines) app is a shared app. Its content can only be edited in its original location.

Home Page Layout

1. When editing a sites home page, keep in mind the pages is broken up into Areas. The app you place in an area will have a different look depending on which area you place it on.

2. Some campus use a Headline app in Area B to display campus news, it will have a similar look to the News From Around The District app on every campus home page (see below). While using this app, please be advised that the size of the app is determined by the largest image. We do ask that you use a standard image size of 411w x 237h. If you do not have a graphic design software you can create simple signs in PowerPoint.
   a. Open PowerPoint
   b. Select Blank Presentation
   c. Click Design, Slide Size from the top menu and choose Custom Slide Size.
   d. On Slide Size dialog box choose: Width = 5.48 Height = 3.16
   e. Choose Ensure Fit on following option.
   f. Create graphic/message
   g. Go to File > Save As and choose the destination. On the Save As dialog box choose .jpg as Save as type.
   h. Click Save
Edit the Multimedia Gallery App

1. Log into Site Manager and access the Homepage page, then click on the Edit icon.
2. Here you will have the option to add New Records, Sort Records, Edit existing records or Delete a record.
3. When creating a new record, you need to fill out the Title and Caption fields. Both of these can be hidden by checking the “Hide” checkbox above the fields. Select the Image by clicking Select File and browsing to the file location and always provide an image alt text (brief image description).

Calendar App

Homepage Calendar View:

You can add a calendar app to any levels of your website. Add events directly to the calendar, import events from an existing calendar, or sync with your Google calendar. Events from other calendars can be posted to your calendar and vice versa.

Calendar Page View:
**New Calendar Entry**

1. Navigate to the calendar where you would like to post your entry and click the **Edit** icon.

2. Browse to the date the event will be held and double click on the date of the event.
   
   *Side note: Event Queue tab shows a list of events shared to your calendar that need approval for them to display in your calendar.

3. Fill out the Event Title and set the Start Date information. You may also provide a description if you want.
   
   a. The event menu provides additional configurations. Many, like recurrence, registration and location are self-explanatory. While **Post to Calendar** allows you to post the event to another calendar. To do so, check the box beside the **Post to other calendar** option. As a default only the site’s main calendar appears as an option, but click on **Add Collection** to view more options.

**Calendar Queue**

As stated above, events from other calendars can be shared to your calendar. To verify your calendar queue, start by going to the page that houses the calendar.

1. Click on the **calendar name**
2. Click on the **Edit** icon
3. Go to the **Event Queue** tab
4. **Approve** or **Deny** event
**Best Practices**

1. **Fonts:**
   - It’s best to use the default font so the size and appearance will be consistent, dictated by your template. To ensure you are using the default font, click the Paste as Text button before pasting in any text that you have copied from elsewhere (Microsoft Word, a pdf, etc.).

2. **Links:**
   - Links to outside web pages should open in a new window, so that your visitor can easily get back to your school site.
   - Verify that links outside your webpages are functioning, current, and appropriate in nature.
   - Consider using PDF format when posting attachments. This will ensure that you will not be denying a user access to a document because of the program in which it was created.

3. **Images:**
   - Resize photos prior to uploading them whenever possible. Otherwise, resize them during the upload process to avoid distortion.
   - Watch for copyright images and logos
   - Homepage Rotator Images
     - Keep objects centered leaving some head and leg room for the banner
     - Size – 915h x 1500w
   - Size
     - Homepage Rotator – 915h x 1500w
     - Headline Image – 237h x 411w
   - Contact communications department for images of your campus

**Accessibility**

1. Use plain language
2. Do not only emphasize content by making it red or bold. Screen readers do not identify those characteristics. Instead use an exclamation mark at the end of a sentence if it’s important, or a question mark at the end of a question.
3. Use proper heading structure
   - A. Don’t skip levels. Don’t use an H3 heading if you haven’t used an H2 heading yet
   - B. The page title counts as the H1 heading
   - C. Don’t select a heading just because you like the way it looks
4. Use text alt for images, it must be representative of content or purpose of the image (see example below)
   - A. Bad – man with baseball bat
   - B. Good – Stadium lights shine while the player holds the bat on the green.
5. Interface must have sufficient contrast between text color and background color.
6. Video:
   - A. Videos should be captioned. To learn more, see about captioning videos.
7. Uploaded Files
8. Use the PDF file format
   - A. PDF (Adobe) file format is one of the most common file formats in use today.
   - B. PDF reader and updates are free.
   - C. Portability – Once pdf is created, it can be shared with anyone and fonts, images and tables go with document.
D. **Version Independence** – Universally compatible, you can open any PDF file in any PDF reader.

E. **Security** – You can secure a PDF file with a password. Once secured, it can only be viewed if correct password is entered.

9. Make scanned objects Accessible (You will need PDF editing software. The instructions specified are for Adobe Acrobat)

   A. Open original scanned file
   
   B. With Adobe Acrobat open select the **Tools** tab from the top bar.
   
   C. Under **Customize**, find **Action Wizard** and select **Add** and then **Open**
   
   D. Once you have opened the **Action Wizard** tool, select **Make Accessible** from the **Tools Pane** (right hand side).

      i. **Add Document Description** = Add Title, Subject, Author.

         a. Uncheck **Leave As Is** if you want to change current settings. Click **OK** when done

      ii. **Recognize Text using OCR** = Converts images of text into text characters.

         a. Click **Recognize Text using OCR** and set the following

            b. Set Document Language = English

            c. Output = Searchable Image

            d. Downsample To = 600 dpi

      iii. **Detect Form Fields** = Scans document for text fields, you can skip this if you know you don’t have fillable fields.

         a. Click **Detect Form Fields** on Tool pane and select **Yes, Detect Form Fields** on dialog box.

      iv. **Set Reading Language**, select document language and click **OK**.

      v. **Autotag Document** = Corrects reading order

         a. Just click **Autotag Document** and Acrobat does the rest.

      vi. **Set Alternate Text** = Scans document for images and alternate text

         a. Look below (section c > iv) at Set Alternate text for document images.

10. Files need to be titled, tagged and Alternate Text added for images.

   A. Using Adobe Acrobat will allow you to do

   B. Title a PDF

   i. Go to file and select Properties

   ii. On the Description Tab, fill out Title field.

   **Document Properties**

   ![Document Properties screenshot]

   **File:** 2019.06.04_LAM_Minutes-OCR-tag.pdf

   **Title:** 2019.06.04 - LAM - Minutes
C. Tag a PDF
   i. Save from Word as Tagged PDF and add Title
      a. Open original Microsoft Word document.
      b. Click File from the menu and select Save as. Choose where you want to save the file.
      c. In the Save As dialog box, choose PDF in the Save as type list.
      d. Add Title below Save as type list
         e. Click the Options button in the same dialog box. Under Include non-printing information section, make sure the Document structure tag for accessibility check box is selected.
      f. Click OK and Save PDF.
   ii. Tag an existing PDF
      a. Open PDF with Adobe Acrobat. *Acrobat reader will only read the document and will not make edits.
      b. With Acrobat open select the Tools tab from the top bar.
      c. Under Protec & Standardize, find Accessibility and select Add and then Open
      d. Once you have opened the Accessibility tool, select Autotag Document from the Tools Pane (right hand side).

D. Set Alternate Text for document images
   i. Locate the Accessibility tool on the Tools Pane.
   ii. Once the Accessibility tool is open, select Set Alternate Text.
   iii. Click OK when the Acrobat message comes up advising it will detect all figures in the document.
   iv. Add the Alternate text on the field provided. Go through the rest of the images by clicking the right or left arrow, adding any alt. text for images. If image is a Decorative figure it does not need alt text. Decorative figures add visual appeal but no additional information (see below).
Additional Blackboard Resources

Hot Topics
Manage Pages
Manage Apps and Layout
Apps and Page Types Help Card
Recommended Practices for Teacher Page
Social Settings
Page Types Overview
Calendar Workbook
Schoolwires Help Resources – Search your topic
Site and Subsite Workspace
Channel Director

Hands on Practice: Before you begin, verify you're logged into Site Manager.

Exercise 1—Add and Edit a Content Page
Directions: Add a new Content Page. Follow the steps below.
1. From the Summary Tab, click New Page.
2. Click on the Content Page type from the list.
3. Type “Practice” in the Page Name field. Click Save & exit to return to list.
4. Click on the “Practice” page from the list. Then hover over the content app and select the Edit (pencil) button.
5. Edit the app as you like.
6. By default, the status of the Content Page is active.
7. If this is acceptable, leave the status as Active. The app will display on the page for viewers specified. (If you have not specified viewers, the app will display for all visitors to the end-user website.)
8. If you wish to hide the app while you edit it, click the ACTIVE button for the page under STATUS. To activate the page again, click the INACTIVE button.

Exercise 2—Change the Page Layout and Add a Calendar App
Directions: Change the Page Layout and add a Calendar App. Follow the steps below.
1. Click Actions to the right of the Practice page you created in Exercise 1.
2. Click Edit Page to access the Page Details window.
3. Select the Layout tab.
4. Choose the Two Column layout for your page.
5. Go back to your Apps Tab
6. Drag and drop the Calendar App from list of Apps to the right column.
7. Type a name for the app. Use a meaningful name so that you can easily identify the app later.
8. Click the Preview button so preview your page.
9. Go back to the layout tab and change it to one column.

Exercise 3—Add a Calendar Event
1. Reference Page 7